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1 – Overview 
he AccessVideo™ system is a complete mobile turnkey telemedicine Video/IP remote 
diagnostic system. It employs state-of-the-art MPEG-4 and Windows Media 9 video 
compression alongside BF Technologies’ proprietary ClearAccessQoS™ advanced 
Quality of Service (QoS) technology to facilitate remote medical diagnoses by capturing 

and delivering live, high-quality video and audio signals across Internet connections. 

The AccessVideo system implements HIPAA compliance through the use of industry standards 
for strong conditional access and encryption to maintain the privacy and security and integrity of 
the video connection. It incorporates a powerful remote Pan/Tilt/Zoom interface to give a 
remote user full control over the transmitted image. A client-side recording capability precisely 
captures and archives audio and video streams for future reference and study. ClearAccessQoS™ 
helps insure jitter-free, clear video even through network congestion.  

The AccessVideo system is built around a flexible yet compact platform, enabling it to capture, 
transport, and render a wide variety of telemedical real-time images and sensory data in addition to 
its audio and video capabilities. Its design allows operation over a wide variety of standard 
Internet connections, including wireless links as low as 96 Kbps, to provide the best quality video 
that current video compression technologies allow.  

The AccessVideo encoder is built around the modular Microsoft DirectX™ system, allowing 
future software upgrades as new compression technologies become available. The AccessVideo 
system works in conjunction with current firewall systems, thereby aiding security and network 
protection. It requires no special client-side setup and only minimal server-side configuration.   

The AccessVideo system provides asymmetric bi-directional video and audio transmission and 
can be configured for a wide variety of compression rates and technologies independently for 
each data direction. 

The AccessVideo system has been field tested and proven in live emergency room deployments 
that include including IRB (institutional review board) certifications. The AccessVideo system has 
been developed to comply with NIH protocols for remote telemedical stroke diagnosis. 

Chapter 

1 
T 



A C C E S S V I D E O ™  U S E R  M A N U A L    R E V . 1 7  

BF Technologies, Inc.  2 

2 - Installation 
he AccessVideo™  telemedical videoconferencing system has been designed for quick 
installation on a wide variety of PC platforms running Microsoft Windows® 2000 or XP 
operating systems.  This section will help you determine if your system meets the minimal 
installation requirements and help guide you through the installation process.  

Minimum System Requirements 
CPU: Intel® Pentium® 4, Pentium® M, or Celeron® running at 1 GHz or faster 

DRAM: 256 Megabytes or more 

Required Disk Space: 10 Megabytes 

Audio capture and playback capability 

Optional video capture or USB port for video camera 

Operating System: Microsoft Windows® 2000 or Windows® XP 

Multimedia Software: Microsoft DirectX® 9.0c or newer and Windows Media Player 10. 
(Both packages are available as an update option as part of the Microsoft Windows update 
from windowsupdate.microsoft.com when choosing the “Custom” option.) 

Although the AccessVideo™ client may run on a system without the minimum requirements 
listed above, such as a slower system, one with a different CPU, or older DirectX software, BF 
Technologies has not tested other such configurations for compatibility, robustness, or reliability. 
However, when running the AccessVideo client, the status bar will continuously display CPU 
utilization as one means of measuring whether the system is keeping up with the processing 
requirements. 

Installing the Application 
BF Technologies makes the AccessVideo client software available in a variety of forms: via e-mail 
attachment, FTP download, flash stick, CD-ROM, or pre-installed. Except for pre-installed 
software, installation consists of installing two packages: AccessVideo-XXX.msi and Common-
XXX.msi, where XXX denotes the build number (407 as of the time this manual was written). 
Note that these MSI files may be delivered as a single ZIP archive, in which case, you must first 
unzip these files to extract them.) 

We strongly recommend that you update your operating system to use the latest patches offered 
by Microsoft. In particular, updating to the latest DirectX® 9.0c (or later) and Windows Media 
Player 10 packages will help insure the best possible video and audio quality. 

T 
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Step 1. If you received a ZIP file, extract the AccessVideo-XXX.msi and Common-XXX.msi  files. 
You can extract these files to any convenient directory and delete them after installation to save 
disk space. We recommend that you keep the original ZIP file in a safe place for backup 
purposes. 

Step 2. Double-click on Common-XXX.msi and follow the directions to finish the installation. 
You can select the installation directory, but we recommend that you use the default installation 
directory for ease of support. 

Step 3. Double-click and complete the installation of AccessVideo-XXX.msi 
You MUST use the same installation directory as in Step 2.  

After completing this procedure, you should see an AccessVideo icon on your desktop.  Double-
clicking this icon will start the client application. 

Registration and Activation 
The AccessVideo client application comes with a free 10-day demonstration license to give you 
sufficient time to evaluate the performance of your particular computer system for compatibility 
with this software. If you determine that the computer onto which you had installed the 
AccessVideo application is compatible with the software and is adequate for producing 
satisfactory audio and video we recommend that you register your copy of the AccessVideo 
software to avoid a disruption in use. The software will NOT run after 10 days unless you register 
your copy of the software on the computer you have installed it on.  

To register the software, click on the menu item: Help/Register. If you are not yet registered, a 
panel will pop open displaying your computer’s identification number. Please e-mail this number 
to info@bf-technologies.com or call us to arrange for us to provide you with a license key. 
Usually, we provide the license key via e-mail. You can simply copy and paste the license key into 
the “License Key” box in the “AccessVideo Registration” panel and click OK to complete the 
registration process. 

 

FIGURE 1. Screen snapshot of AccessVideo Registration panel. 
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Computer Settings 
The following settings will help insure optimal performance. 

• SCREEN SAVER should be disabled or set to a long enough interval so as to not interrupt 
session: right-click on screen background; click properties; click Screen Saver tab;  either 
increase wait time as desired or select (None) screen saver. 

• If using a microphone connected to the mic input, then the microphone must be selected 
as the AUDIO INPUT DEVICE: click Start / Control Panel; double-click on Sounds and Audio 
Devices; select Audio device; make certain that under Sound recording the correct default device 
is selected, especially if a USB video camera having a mic is plugged in; click on Volume…; 
select microphone and adjust volume. Mic volume can be adjusted while application is 
started. 

• Make certain that speakers are connected and set to the proper volume.  Bring up Sounds 
and Audio Devices panel as described above to adjust volume under the Sound playback 
section of that panel. 

3 - Application Setup 
o bring up the application setup panel, click on the Settings… option under the File menu. 
The options you see on this panel (Figure 2) provide general defaults and video and 
connection characteristics that apply to the setup of all links.  

Target Response Time 
The Target Response Time lets AccessVideo™ know what the maximum total round-trip signal 
delay that you are willing to allow to help it optimize signal robustness. A smaller value provides a 
faster, interactive conferencing experience, but at the expense of making the connection more 
susceptible to Internet interference and data loss. Conversely, a larger value provides for a more 
robust signal, but with longer delays. You specify the total response time in milliseconds. The 
minimum value is 400 ms (0.4 seconds) in order to account for encoding and synchronization 
delays (100 milliseconds for encoding in each direction and 100 milliseconds of synchronization 
buffering in each direction to account for clock frequency drift). This is a target value only.  The 
AccessVideo™ attempts to honor this constraint, but if FEC or ARQ is checked (see below), 
AccessVideo™ may add additional latency to provide a basic level of service quality protections. 

Synchronization Drift / Capture Jitter Tolerance 
Synchronization Drift and Capture Jitter Tolerance adds this amount of initial jitter buffering to a 
connection to account for variations in video capture timing and network clock synchronization. 

T 
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FIGURE 2. AccessVideo™ setup panel. 

Quality-of-Service (QoS) Defaults 
BF Technologies’ AccessVideo™ technology incorporates two different and complementary 
error correction mechanisms: Forward Error Correction (FEC), and Automatic Repeat reQuest (ARQ). 
Settings under the QoS Defaults box provide initial default values for AccessVideo™ FEC and 
ARQ error correction. However, these settings can be over-ridden under the settings for each 
individual connection.  

Clicking Robust Mode for a particular error correction mechanism biases the automatic 
configuration of that setting towards a more robust, error-free connection at the expense of 
longer latency and delay. For ARQ error correction, AccessVideo automatically adjusts and adapts 
the ARQ parameters to the current network conditions. To understand the advantages and 
disadvantages of these two error correction mechanisms and to learn when and how to adjust 
each of these mechanisms, please see the AccessVideo section in the Adding Connections 
chapter, below.  

ARQ detects when a packet is missing and sends a message to the AccessVideo server to request 
a replacement. However, this process takes time. The Target Response Time, less 400 milliseconds, 
constrains the amount of additional round-trip you are willing to tolerate in order to provide 
AccessVideo ARQ with time to make this packet resend request. AccessVideo automatically 
measures the round-trip delay to the server and back and will increase the number or retries to 
match the time you allot. Burst Drop time specifies the length of time that a connection may be 
interrupted, yet still be protected against data loss by ARQ.  
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In Robust mode, AccessVideo may slightly exceed the target latency to insure a minimum or 2 
retries, to provide, at minimum, a second chance in case the network drops either the first request 
or a resent data packet. With Robust mode off, AccessVideo attempts to keep the added latency to 
under the target you specify, with the constraint of a minimum of one ARQ retry. 

Video Settings 
The application settings panel provides three settings that directly control video capture and 
playback: Std. Resolutions, Freq Lock, and Drift Comp.  Checking Std. Resolutions constrains the size of 
the video capture resolution to fall within a standard video resolution. Should a user request a 
non-standard video resolution, during the negotiation for a connection, AccessVideo would force 
the connection to fall back to the next lower standard video resolution. Standard video resolutions 
are: 640x480 (4-CIF), 320x240 (CIF), and 160x120 (QCIF). 

Normally, AccessVideo assumes that the video frequency is a standard rate of 29.97 for NTSC 
and 25 for PAL. (AccessVideo automatically selects PAL or NTSC mode to match the selected 
video resolution.) Freq. Lock instead allows AccessVideo to automatically measure and set the 
video frequency. This is particularly useful for use with inexpensive video capture devices that 
may capture video at lower rates, such as 10, 12, or 15 frames per seconds.  

When trying to lock to a video frequency, a variable time delay, called Drift, may be introduced by 
the video signal. Over time, this drift may cause the video and audio signals to loose lip-sync and 
become misaligned. Drift Comp monitors this phase drift and resets the delay to force the video to 
remain in sync with the audio. 

Security Options & HIPAA Compliance 
The AccessVideo™ telemedicine system is fully HIPAA compliance and includes a number of 
security options as a result. Among the main security features are: Secure Login using SSL 
conditional access, password encryption, strong media-stream encryption, audit trails, and intruder 
alerts. Most of these features are either automatic or configured on the AccessVideo server. On 
the AccessVideo client application, you must set up a username and password for each 
connection to an AccessVideo Server. As general settings for all connections, you must select 
whether to encrypt the conditional access login interaction with the server using SSL, and select 
whether you want to enable Password Encryption, as described in this section. 

SSL Conditional Access 
SSL stands for Secure Socket Layer. It is an IETF (International Engineering Task Force) standard 
used by Internet Web browsers to protect and encrypt sensitive data across the Internet. 
AccessVideo™ uses public-key RSA 128-bit strong encryption, the same encryption used across 
the Internet to protect credit-card information in e-Commerce. With SSL Conditional Access 
checked, password and user information sent to the server to allow access is encoded and kept 
secure. We recommend that you always keep this box checked. 
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Password Encryption 
Password Encryption is an additional security feature of AccessVideo™ that encrypts the passwords 
for each connection before storing them to your computer’s hard drive. If your computer ever 
was stolen or broken into, password encryption protects these passwords from being read. With 
Password Encryption on, AccessVideo™ will ask you for a password when first starting up. This 
password will be used to decode the individual passwords stored by AccessVideo™ for each 
connection. If you provide an incorrect password, the individual connection passwords will be 
incorrectly decoded and will thereby prevent unauthorized access to any of your AccessVideo™ 
servers.  

Encoder Selection 
By design, AccessVideo™ allows the use of a selection of various video and audio encoders. 
Upon request as an additional option, BF Technologies can add support for additional video or 
audio encoders. Currently however, AccessVideo™ only provides support for Microsoft’s 
Windows Media® 9 (WM9) encoding. 

WM9 is the latest video encoding technology offered by Microsoft as part of its Windows Media 
Player 10 package. WM9 is based upon MPEG-4 VC1, which is similar to MPEG-4 AVC, and is 
currently one of the most advanced and efficient video encoders available today. WM9 has been 
selected to encode many popular high-definition videos on DVDs. Because of the many 
advantages of WM9, WM9 is selected by default and is the recommended video encoder. 

4 - Adding Connections 
he AccessVideo client application maintains a list of user-specified connection profiles. 
Each connection profile stores all the parameters for that individual connection, 
including hostname, QoS settings, and send and receive settings.  By default, the main 
application window displays a detailed view of all of the connections, showing all the 

parameters for each connection. However, the user may select from among several alternate views 
of the connections as listed under the View menu to simplify the display of the stored connection 
profiles. 

An important feature of AccessVideo is its ability to measure the end-to-end Internet connection 
speed and latency in each direction for a selected connection and to automatically reconfigure the 
session resolution and data rate in order to produce an optimal video session. It will use these 
measurements to automatically set the ARQ parameters to minimize packet loss and connection 
latency. 

 

 

T 



A C C E S S V I D E O ™  U S E R  M A N U A L    R E V . 1 7  

BF Technologies, Inc.  8 

FIGURE 3. Connection list. 

Connections List 
When started, AccessVideo™ opens a window with a list of your connections to AccessVideo 
servers similar to Figure 3. The first “connection” listed, New Connection…,  is not actually a 
connection at all, but a selection to allow you to create new connections. Alternatively, the 
Connection menu will allow you to create, edit, or delete connections. It will also allow you to start 
and stop a connection, restart the AccessVideo™ AutoQoS and automated bandwidth 
measurements for link calibration, and access various connection statistics. You can also right-
click on a connection as a shortcut to some of these features.  

To add a new connection, double-click on New Connection… and a new connection panel will pop 
up. To edit an existing connection, select the connection from the connection list by a single 
mouse click, and then select Edit from the Connection menu. A connection panel, similar to that 
shown in Figure 4 will appear. A connection panel has four tabs: Connection, Network, QoS, 
Send, and Receive. Each tab has its own panel, as described below. 
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 FIGURE 4. Editing a connection. 

Connection Panel 
The Connection Panel, as shown below in Figure 4, provides general information about the 
connection, such as the connection name and user login information. You must enter a name for 
the connection. This connection name can be any arbitrary name you choose. You must also 
enter a valid username and password. You should contact the AccessVideo server administrator 
to set up a user account. The description field is only added as a convenience to store notes about 
the connection. You can ignore this field. 

Network Panel 
The Network Panel allows you to specify general network connection information to reach the 
desired AccessVideo server. The most important parameter is the Hostname. Under the Hostname 
field of the network panel you must enter either the IP address for the AccessVideo server, or 
otherwise enter the fully-qualified hostname. The rest of the parameters, such as SSL Port, Jitter, 
Uplink Speed, Downlink Speed, Auto QoS, Encrypt, and Camera Control come pre-configured with 
reasonable defaults. You can change any of these settings, but be aware that the Uplink and 
Downlink Speeds are automatically updated when you measure the connection speed and the Jitter 
field is updated whenever you start a connection and the Auto QoS setting is enabled.  
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QoS Panel 
QoS stands for Quality-of-Service and provides full access to the configuration of the 
AccessVideo™ error correction mechanisms. AccessVideo implements two advanced, patent-
pending, error correction mechanisms, a Galois-Field based Forward Error Correction (FEC) and 
an automatic repeat request (ARQ) mechanism. Either, both, or none of these error correction 
mechanisms may be enabled on a connection. 

FEC 
AccessVideo™ FEC uses a new patent-pending approach to forward error correction for video 
over IP that bounds the generation of checksum packets to within a maximum fixed time period, 
generally set to 100 milliseconds. Because of this new FEC technique, a receiver will never have to 
wait longer than this time interval before releasing the incoming video for display, thereby 
minimizing jitter and latency on the receiver. Another novel aspect of QVidia’s AccessVideo™ 
FEC is the implementation of a new form of FEC checksum generation based upon Galois-
Fields that allows any number of checksum packets to be generated for a single FEC data block. 
This provides over twice the error recovery when compared with standard parity-based FEC that 
generates only a single parity checksum packet per data block, and requires interleaving data 
blocks to recover from a burst packet loss. 

To enable QVidia AccessVideo™ FEC processing, you must check the On checkbox under the 
FEC section of the QoS panel. The Overhead checkbox under this section specifies the number of 
FEC packets to generate in relation to the media-stream data packets, calculated as a percentage 
of these data packets, and rounded up to the nearest whole number of packets. Checking the 
Robust box increases the maximum period of time before forcing the generation of an FEC packet 
from 100ms to 167ms, and also increases the minimum number of FEC packets per data block 
from 1 to 2 checksum packets. 

ARQ 
QVidia AccessVideo™ includes a patent-pending automatic retransmission request (ARQ) 
mechanism based upon the well-known Selective Retransmission Protocol (SRP) of Piecuch et. al. 
that can completely restore all dropped packets; even under extremely poor and dynamically 
varying network conditions. Unlike FEC, which sends a fixed number of error correcting packets 
regardless of network loss conditions, AccessVideo™ ARQ automatically asks for replacement 
packets whenever the receiver senses any packet loss, and can repeatedly ask for as many packets 
as are required to completely restore all lost media stream packets.  Or when no packets are lost, it 
may not send any packets at all. And in contrast to TCP/IP protocol, SRP is sensitive to the 
timing of video and other real-time signals, so that it can guarantee that packets are replaced in 
time for play out at the user’s display, without any interruption in the received video or audio 
stream.  AccessVideo™ ARQ adds a user-specified amount of latency (i.e. delay) to the video 
stream to allow time to request and receive retransmission of a lost packet and insert it into its 
proper sequence in the video stream in time for play out. 

To enable QVidia AccessVideo™ ARQ, you must check the On checkbox under the ARQ section 
of the QoS panel. The Auto QoS feature of AccessVideo™, when enabled, will automatically 
measure and configure all the other parameters, such as Num Retries, RT Time, and Burst time. The 
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Robust Mode checkbox under this section forces a minimum of 2 retries when Auto QoS is enabled, 
regardless of the target latency. 

Send Panel 
The Send Panel provides the parameters to configure the outgoing video and audio streams for 
transmission from the AccessVideo client application to the AccessVideo server. To enable 
upstream video transmission, you must check the Send checkbox in the Video section. For a 
minimum video resolution of 160x120 pixels (QCIF), we suggest using the default of 128 Kbps 
for the bit rate. A common value for higher resolution is 320x240 pixels (CIF). For this higher 
CIF resolution, we suggest using at least 300 Kbps, although it is possible to achieve acceptable 
video at bit rates as low as 240 Kbps. For many low-cost USB web cameras, such as the 
Logitech® QuickCam® Pro, which work only at these two resolutions, we suggest checking the 
Std. Resolutions checkbox under application settings. 

To enable the transmission of audio from the AccessVideo client to the AccessVideo server, you 
must check the Send checkbox under the Audio section. We suggest selecting the default bit rate of 
44,100 bits per second. This selection uses the same type of encoding (ADPCM) that was 
originally developed by ATT for their telecommunications systems. It provides a good 
compromise between minimizing the bit rate, while allowing good echo cancellation. Higher 
bitrates, such as 56 Kbps or 128 Kbps, uses the same MP3 encoding found in portable music 
players, and provides exceptionally high audio fidelity. However, MP3 encoding uses far more 
CPU power and increases the encoding latency by about 60 ms. The lowest audio bit rate 
selection generates only 8 Kbps, but will generally impair the automatic echo cancellation system 
and result in high levels of received echo.  

Receive Panel 
The Receive Panel provides the parameters to configure the resolutions, bit rates, and audio 
encoding for incoming video and audio streams from the AccessVideo server to the AccessVideo 
client. Downstream video transmission from the server is always enabled. However, you should 
select the video resolution that best suits your needs. The default resolution of 400x300 pixels 
provides a resolution about twice that of a VHS video recorder, but about half that of a DVD 
player. It can generally receive good video quality at 600 Kbps, but may function well from bit 
rates as low as 450 Kbps. The default of 750 Kbps provides exceptionally high quality over a wide 
range of video scenes. 

To enable the transmission of audio from the AccessVideo server to the AccessVideo client, you 
must check the Receive checkbox under the Audio section. As with Audio Send, we suggest 
selecting the default bit rate of 44,100 bits per second, as it provides a good compromise between 
minimizing the bit rate, while allowing good echo cancellation. As with Audio Send, higher 
bitrates, such as 56 Kbps or 128 Kbps, uses the same MP3 encoding found in portable music 
players, and provides exceptionally high audio fidelity. However, MP3 encoding uses far more 
CPU power and increases the encoding latency by about 60 ms. The lowest audio bit rate 
selection generates only 8 Kbps, but will generally impair the automatic echo cancellation system 
and result in high levels of received echo.  
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5 - Connection Startup 
ith your server connections entered from the previous chapter, we are now ready to 
describe the actual operation of the AccessVideo™ system. 

 

Precautions 
Personal computers and the Internet were never initially designed to handle multi-media traffic 
and applications. Be design, computers are multi-functional systems that generally operate many 
software applications concurrently. AccessVideo™ and Microsoft Windows® have added many 
unseen features into the fabric of their software to help mitigate disturbances to video and audio 
content. However, video and audio applications are still susceptible to disturbances and 
interference by other applications. AccessVideo™ is no exception. Please be aware that activating 
or interacting with other windows, software applications, or your computers devices or 
peripherals may interfere with the smooth delivery and performance of your audio/video feed.  

In order to assure the highest quality video and audio feeds, please refrain from accessing 
other software applications during an active AccessVideo™ session.  

Link Measurement 
AccessVideo includes an automated connection measurement tool that will measure both the up 
and downlink speeds from the client to the server and automatically store the measured speeds 
for the connection it measured as part of the connection parameters under the connection’s 
network settings. To access this feature, first highlight the connection you would like to measure 
by a single mouse click, and then click on Measure Bitrates from the Connection menu item of the 
main connection list window. You can monitor its progress along the bottom bar of the 
connection list window as it measures the up and downstream bit rates. When the bit rate 
measurement completes, it fills the measured values into their appropriate fields in the network 
tab for the connection. 

Startup and Auto QoS 
Double-clicking on a connection in the connections list will start a connection and turn the 
Connection List into a video window. If AutoQoS is enabled, AccessVideo™ will measure the 
connection characteristics for about 10 seconds to automatically optimize the QoS and error 
correction features of AccessVideo™.  If anytime later you suspect that the network 
characteristics have significantly changed, you can click on Reset Auto QoS under the Connection 
menu item to reset the QoS settings to the latest line and network conditions. Because 
AccessVideo™ is always measuring the network conditions, resetting auto QoS instantaneously 
updates the QoS settings.  

W 
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Note:  Resetting the QoS settings may cause a momentary pause or disruption in the video or 
audio feed. For this reason, the QoS settings are not continuously updating.  

Caution: Do NOT access the camera controls either during the initial QoS measurements or 
anytime just prior to an auto QoS reset. Also we strongly advise against opening, moving, 
activating, or closing any other software applications or windows during the initial QoS 
measurement or just prior to an Auto-QoS reset. Any such disturbances during an auto QoS 
measurement may result in inaccurate QoS settings. 

Connection Quality Indicator Lights 
AccessVideo continuously measures connection characteristics and monitors connection quality 
to insure the highest possible video signal. This connection monitoring automatically works in 
conjunction with QVidia’s AccessVideo™ ARQ to automatically attempt to request and recover 
any packets lost in transmission over the network. In certain rare occasions, the Internet or a 
wireless link may briefly lose connectivity or otherwise cause enough of a disruption in the 
transmission or reception of packets between the server and client that none of the AccessVideo 
error correction mechanisms are able to recover all packet losses. In such cases, even a single 
packet loss will trigger one of the two quality indicator lights that appear along the lower left 
corner of the video window.  

These two connection quality indicator lights change color between yellow, red, and green, 
depending upon the status of the audio and video signals being received. The left-most indicator 
shows the status of the audio and video stream currently being received and displayed by the 
AccessVideo client application. The indicator to its immediate right shows the status at the server 
end of the connection and whether a person watching or listening to the video at the server end is 
getting a lossless video/audio feed. As long as video and audio packets continue to arrive in time 
and without any loss, so that the audio and video played out to the user has no network-induced 
flaws, these indicators will stay green. Any packet loss will cause the corresponding indicator to 
change from green to red for at least one second. When first starting a connection, during the 
period when AccessVideo™ is measuring the link characteristics, both of these indicator lights are 
yellow. However upon completion of these QoS measurements, AccessVideo™ will reconfigure 
the QoS parameters to reflect the current network conditions. This initial reconfiguration of the 
parameters may cause a momentary pause in the video/audio feed, as buffers are refilled. During 
this possible initial pause both indicators may briefly change to red. However, after this transient 
condition passes, under normal conditions both indicators should revert back to green and remain 
green unless or until it senses unrecoverable packet loss. 

Camera Control 
With Camera Control enabled and a connection starts, a camera control toolbar will appear along 
the top of the video window. With the Camera Control checkbox unchecked, the camera control 
will not appear. From left to right, this camera control toolbar has the following controls: 6 local 
camera setting presets, a set button, a slider bar for horizontal panning, up/down arrow buttons 
for tilting the camera, a slider bar to zoom the camera, a Back button to revert to the previous 
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camera pan/tilt/zoom position, 3 global camera setting presets, and a record button to start and 
stop recording of the video session to a local file.  

The local camera presets each store a pan/tilt/zoom value on the local computer running 
AccessVideo client for quick repositioning of the camera. To set a preset, first move the camera 
to the desired location, click on the set button, and then click on the preset button to which you 
would like to store the camera position. Once stored, the camera preset will always be available, 
even after powering off your computer or the server.  

The 3 global presets (to the right side of the camera toolbar) work the same way as the local 
presets. However, they store the camera position within the camera itself, so that the setting 
becomes available from any computer and to any user who accesses the AccessVideo server.  

To move the camera horizontally, you can either left-click on slider control and, while holding 
down the mouse button, move the slider control to the desired position and release. The camera 
will move after the mouse button is released. You can also left-click on the white space to the left 
or the right of the slider control to move the camera by a large fixed increment. For fine motion 
control first left click anywhere within the video window so that the keyboard keys will apply to 
the entire view (if you had previously clicked on the slider, then the keyboard would only apply to 
the slider control until you let-click within the video window), you can hit the left-arrow key to 
move one small increment left and the right-arrow key to move right. You can hold down the 
shift key while pressing the arrow key to double the amount of movement. 

Simplified Camera Control 
AccessVideo provides a much simpler, more automated interface to controlling the camera on the 
server. To center the view, you can simply right-click anywhere in the video and the camera will 
automatically pan and tilt such that the point that was clicked on would become the new center of 
the view. Alternatively, you can use the left mouse button to draw a rectangle over a portion of 
the view by holding down the left mouse button, dragging the mouse to draw the new view area 
within the current view area, and then release the mouse button. Upon releasing the mouse 
button, the camera will automatically scale the zoom factor as well as move the camera such that 
the drawn view rectangle will fill the screen. 

Recording a Video Session 
To record a video clip from a live stream, first configure a file name for the clip from the Capture 
Settings… panel under the File menu. By default, AccessVideo will use the data/time stamp as the 
file name and place the file on the desktop. To begin the recording, click in the Rec button on the 
camera control toolbar. Clicking the Rec button again, so that the button is out, its default state, 
will stop the recording. 

Still Image Capture 
In addition to capturing video clips from a session, AccessVideo also provides the ability to 
capture snapshots of a video frame during the video session and store them as JPEG-compressed 
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pictures. To take a snapshot, i.e., a capture a still image, from a live video stream, just click on Save 
Image menu item from the File menu. A JPEG file (having a .jpg suffix) will appear in the directory 
specified by the file name in the Capture Settings… panel under the File menu. 

Connection statistics 
AccessVideo keeps detailed statistics on a connection when it is running. Four menu items under 
the Connection menu provide access to these statistics: Receive Stats, Send Stats, Remote Send Stats, and 
QoS Stats.  In particular, clicking on Receive Stats will bring up a window showing the statistics for 
the video stream currently being received. The Dropped value under the ARQ statistics shows the 
number of lost video packets, even after applying ARQ error correction, if any. You can compare 
this number to the Dropped value under the Network statistics to see how well the AccessVideo™ 
technology is working to restore lost packets.  

Media device properties 
The Media menu list provides fine control over the video and audio capture device along with 
access to the video and audio encoders. These menu items are only enabled when the parameters 
are able to be modified and only for devices and encoders and decoders that allow access to their 
internal parameters. Thus, some of these windows may only be accessed when AccessVideo is in 
an idle, unconnected state, while other may only be enabled during a connection-started state. 

Controls 
The Control menu list provides access to certain controls on the server’s video camera and also 
allows access to certain audio-specific settings. These controls are generally accessible when a link 
is active. 

6 – Troubleshooting 
Elow, we include a list of common problems and some suggestions for overcoming 
them. 

 

Cannot connect to server 
The client cannot send a packet to the server. Please check that the IP address or hostname is 
correct and that the server is up. Often, it may mean that the server is down or off-line. 

B 
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Server busy message 
Only one user can connect into a system at a time. This message means that another user has 
logged into the system and is using the server. You must wait for that user to disconnect before 
trying to connect again. 

Choppy audio or video 
A poor Internet connection will drop packets and cause the video to pause or become jerky. 
Likewise, lost audio packets will cause pops, drop-outs, or other artifacts on the audio.  You 
should disconnect and then try increasing the QoS parameters or re-measuring the bit rate before 
reconnecting. 

Screeching noises with audio 
AccessVideo servers come with an echo-cancelling microphone on the server, but no echo 
cancellation on the client side. If you enable audio send and receive and do not use a headset or 
directional microphone on the client, you may experience feedback problems that manifest itself 
as a screeching or howling noise.  Try lowering the speaker volume and/or microphone sensitivity 
and speak closely into the microphone.  

Excessive delay 
The round-trip connection delay is usually set to the Target Response Time as set under the 
File/Settings… menu. However, setting Robust mode for ARQ may increase the total connection 
delay. You may wish to turn off Robust mode or lower the target response time and suffer with a 
higher degree of packet loss if the delay becomes unacceptable.  

Also, slow link speeds will add to connection latency to accommodate large bursts of video data. 
If you are able to obtain a higher connection to the server or reduce the video resolution, the 
delay can often be lowered significantly. 

Support contacts 
For troubleshooting information and the latest software, please contact BF Technologies either by 
phone or e-mail at: 

 
Phone: (858) 437-1136 
E-mail: support@qvidia.com 
 

Support Hours: Monday - Friday 9:00 am to 5:00 pm PST 
 
  


